Planning urban areas

- Wizards
- Map production
- 3D presentations
- Annotation
- Orthophoto
- Surface gridding
- Contouring
- Image mosaicing
- Data compression
- Geocoding
- Spatial analysis
- Raster to vector
- Land use classification
- Data integration
- Image analysis
- Radar processing
- Fast Fourier Transforms

Put your GIS data in real world context
Merge your GIS data with aerial photos or satellite data to give it a real world feel.

Get full value from your images
Use comprehensive and flexible tools to analyze your data.

Produce maps and reports
Create maps or images for studies, plans or impact reports.

Get the 3D picture
Use powerful 3D flythrough and perspective viewing.
1. Add imagery to your GIS

Whatever your application, your GIS data is easier to understand with an image backdrop. With ER Mapper you can create geographically-aware backdrops that fit your GIS data accurately. You also get GIS editing and annotation tools in one comprehensive package. Now you can be confident your decisions are being made using up-to-date information.

“ER Mapper is perfect for handling our aerial images, mosaicing, enhancements, and rectification... It is a vast improvement on anything I’ve used in the past.”
-- Mario Gismondi, Survey Graphics

“ER Mapper is a powerful and efficient tool for the study and management of earth resources.”
-- Dr Liu Jian Guo, Department of Geology, Imperial College, London

Overlay GIS data on your backdrop image

ER Mapper #1 for integrating GIS data
✔ View GIS over ‘real world’ backdrops
✔ Update Arc/Info coverages directly
✔ Merge images, GIS data and database information
✔ Exchange data with Autodesk World, AutoCAD Map, ArcView, MapInfo, Intergraph and other compatible formats
✔ Use ER Mapper images directly into your GIS with free plugins for AutoCAD MAP®, ArcView®, MapInfo®, Microsoft® Office programs and Autodesk World 2.0™

2. Analyze your images

So you can get the most information out of your images, ER Mapper provides you with a full set of image analysis tools. Highlight land cover types and changes over time, and assess environmental impact. Highlight areas and save them as vectors for your GIS using powerful raster-to-vector conversion tools.

ER Mapper #1 for wizards - mosaicing
✔ Powerful and easy to use
✔ Mosaic any number or types of images
✔ Balance and correct color
✔ Hide stitch lines to create seamless mosaics
✔ Integrate your mosaic with your GIS data

Mosaic of 4 airphotos before color balancing

With color balancing

Classify data and combine with vectors to create detailed maps
urban planning easier

3. Visualize in 3D

One 3D image says so much more than any number of 2D pictures. By understanding the terrain and viewing your area of interest from all directions, you can see for yourself what the impact of a proposed development will be. 3D really does add a whole new dimension.

“Users are able to produce professional looking maps that would make even the most demanding of cartographers drool with envy.”
-- Desktop Computing, The Star.

Present your imagery and vector data in 3D for greater impact

4. Create powerful presentations

Creating professional presentations is critical for Urban Planners. ER Mapper offers a complete suite of tools to generate images and maps of the highest quality, at any size or scale. Print them out, save them as graphics files, or simply paste them into your word processor or spreadsheet to include them in a report or plan.

ER Mapper #1 for 3D viewing

✔ Fully integrated 3D processing on your PC at an affordable price
✔ 3D flythrough including vector data
✔ Print stunning full resolution 3D prints at any size
✔ Create spectacular multi-surface views to combine more information
✔ Save 3D images as pictures for reports

ER Mapper #1 for mapping

✔ Produce maps quickly and easily using drag-and-drop map objects
✔ Expandable map objects library
✔ Standardized easy-to-use map production tools
✔ Incorporate 3D views in a map
✔ Use smart map items, such as grids that automatically fit your image and North arrows that always point north

View site impact from any angle in 3D

ER Mapper #1 for wizards - image compression

✔ Image compression with real time decompression
✔ Breakthrough technology to compress large images
✔ Achieve compression rates of 10:1 to 15:1 for grayscale imagery and 25:1 to 50:1 for color imagery
✔ High quality compressed images adjust your compression to the desired results.

5. Try for yourself

Evaluate ER Mapper with the free CD-ROM which contains:
• The complete ER Mapper software
• 14 day evaluation licence
• Online manuals
• Over 400Mb of sample data
Case study — Flood plain mapping

Application by California CAD Solutions, Modesto, California, USA

In January 1997, record flooding in California’s San Joaquin Valley washed away previous high water marks from earlier floods in the area. Especially hard hit was the city of Modesto in Stanislaus County where waters rose 16 feet above flood stage, inundating many areas that should have remained high and dry according to Federal Emergency Management Agency (FEMA) flood plain maps.

The new high water line had to be mapped quickly—before the flood waters receded. At the request of Stanislaus County, we began mapping the high water mark so the updated flood plain data could be overlaid on existing GIS maps of the county to direct relief efforts and prepare for future floods.

Black-and-white aerial photos of Modesto were taken at 1:1000 scale, precisely as the flood waters crested. A GPS survey was also made at the same time. Several value-added firms warned the county that digital maps could not be made from the photos in less than a month. That would have been too late—flood clean-up was about to begin and more torrential rain was predicted.

We decided to process the photos and create the maps in-house. We scanned twenty 9"x9" photos and imported the digital files into ER Mapper for rectification and mosaicing. The image files were huge—28 megabytes individually and over 400 megabytes after mosaicing. In spite of this, screen regenerations in ER Mapper took only three seconds every time a histogram balancing routine or other processing function was applied. This file handling speed really impressed us and allowed us to complete the rectification and mosaicing project in three days.

We output the photo-mosaic from ER Mapper into TIF format to use in AutoCAD where it was overlaid on an existing GIS base map to delineate the 1997 high water mark and create a new flood plain vector. We also output a second photo-mosaic file in ArcView format for the county GIS office to use to create flood maps for its emergency personnel.

Stanislaus County has fully integrated the new flood plain map into its GIS. In the event of future floods, the county plans to overlay the new vector layer on street centerline and parcel basemaps to direct property evacuations in a timely and efficient manner.

Advantages of ER Mapper

We found the following characteristics of ER Mapper advantageous for this project:

✔ Ability to process extremely large digital image files very quickly without having to create intermediate data files.
✔ Ability to apply numerous routines and processing functions to large datasets with a minimal amount of disk space.
✔ Ability to import/export files directly from/to other commercial GIS packages.
✔ Ability to perform high-end image processing on a standard Pentium desktop computer with 64 megabytes of memory.
✔ Ability to perform automated histogram balancing and edge matching of images during mosaicing.
✔ Ability to automatically rectify scanned aerial images using standard GPS points.
✔ Ability to create very high quality image prints with annotations directly in the image processing system.
Case Study — Mapping Flight Lines for Pesticide Spraying

Application by Macomb County, Department of Planning & Economic Development, Michigan, USA

For more than a century, gypsy moths have ravaged deciduous and coniferous trees in the Northeastern and Midwestern United States. In a single summer, the moths in their larval stage have been known to defoliate entire forests.

The Michigan State Cooperative Extension Office saves hundreds of acres of trees from gypsy moth infestation each year through careful application of chemical pesticides. In 1997, the Extension Office called upon the Macomb County Department of Planning & Economic Development to assist in digitally mapping flight lines for a computerized aerial application system.

The Extension Office provided USGS quad maps which field crews had used to mark locations needing chemical applications. The maps also delineated specific properties whose owners had objected to the spraying. The Planning Dept. pulled 1"=100' and 1"=300' aerial photos of these areas from its archive and scanned them using in-house equipment. We imported the scanned photos into ER Mapper and overlaid them on an orthorectified SPOT satellite image of the county.

Next we rectified the air photos on screen by locating control points on the image and matching them with the photo points. The rectified photos were automatically registered to the Michigan State Plane Coordinate System by the software.

Once in a real world coordinate system, the photos were pieced together in ER Mapper using the automated Edge Map (feather) and Color Balancing (histogram match) routines to create seamless, multi-scene photomosaics.

A total of six photomosaics, each comprising four to seven photo scenes, were created to map the major spray application areas in the county. Some mosaics were as large as 50 megabytes, but we had no trouble applying enhancement functions to them in ER Mapper.

We then used the ER Mapper MapInfo Link add-on to display the mosaics in MapInfo desktop mapping software. This link enabled us to delineate vector polygons from the mosaics on screen in the mapping software. Vector layers were created for chemical application sites as well as the objectors’ properties and water bodies to be avoided.

We provided these vectors as digital text files to the Extension Office, which in turn gave them to the aerial application contractor. The contractor loaded the files into a software program called SatLock II that output flight lines to guide the GPS-based navigation systems on the aircraft and notify the pilot when to activate the sprayer. ER Mapper really accelerated the whole mapping process and made the chemical application process much more accurate.

Advantages of ER Mapper

✔ Ability to process extremely large digital photo files very quickly without creating intermediate data files.
✔ Ability to apply multiple routines and processing functions to large mosaics with minimal disk space.
✔ Ability to tile air photos of two different scales to create a mosaic at one scale.
✔ Ability to perform high-end image processing on our standard Dell Pentium desktop computer with 64 megabytes of memory.
✔ Ability to perform automated histogram balancing and edge matching of images during mosaicing.
✔ Ability to rectify scanned aerial images using an on-screen overlay with a satellite image.
✔ Ability to overlay air photos and satellite image without exceeding memory capacity of the system.
✔ Ability to link ER Mapper native files directly into MapInfo.
Getting started with ER Mapper

Here are a few tips to get you started with visualizing and integrating GIS data and images.
These examples use sample data that is installed when you select either the “Typical” or “Full” ER Mapper installation options.
If you have not received a CD-ROM please contact your reseller.

Viewing images
A unique feature of ER Mapper is the ability to display the same dataset in different ways to aid interpretation. Here we will create an RGB image of a Landsat scene.

1. On the Standard toolbar, click the File open button. The Image Display and Mosaicing Wizard opens.
2. From the Directories menu, select the path ending with the text \examples.
3. From the directory ‘examples\Shared_Data’ Select: ‘Landsat_TM_year_1985.ers’
   An RGB image displaying bands 3, 2 and 1 is displayed with a 99% clip.

4. In the Algorithm dialog, from the Edit menu select Add Raster Layer, and then Height.
5. On the Layer tab click the Load Dataset button and select the ‘examples\Shared_Data’ directory and the ‘Digital_Terrain_Model.ers’ dataset.
6. In the Algorithm dialog box, select the 3D Perspective View Mode.

Viewing in 3D
1. From the Common Functions toolbar click the View Algorithm for Image Window button.
The Algorithm dialog box opens. This shows a schematic diagram of the data and processing displayed in the image. Currently, there are Red, Green and Blue layers showing bands 3, 2 and 1 respectively of the Landsat image.

Overlaying an ARC/INFO coverage
As well as displaying ARC/INFO coverages, with ER Mapper you can also edit and save coverages in their native format.
1. In the Algorithm dialog box, from the Edit menu select Add Vector Layer and then ARC/INFO Overlay.
   In the Algorithm dialog, an ARC/INFO layer is added.
2. Click on the Dynamic Link Chooser button on the Layer tab. For the dataset choose ‘examples\Shared_Data\arc_info_workspace\sandiegrds’ to select the La Jolla roads coverage.
   Note: Do not open the ‘sandiegrds’ folder instead highlight it and click Select.
3. Select a Line Width of 1.0 point and click OK.

You can repeat this process to add other coverages.
Creating an image mosaic

In this exercise you will use the Mosaic wizard to learn how easy it is to display overlapping images in different layers to create an image mosaic.

Note: The sample images used in the following exercise were previously rectified to the same map projection.

1. If you are following on from the previous exercise close the algorithm window.
2. On the Common Functions toolbar, click the Image Display and Mosaicing Wizard button.

The Image Display and Mosaicing Wizard opens

3. Click the Load Image button.
The Select File dialog opens.
4. From the Directories menu, select the path ending with the text \examples.
5. From the directory 'Applications\Airphoto\1_Geocoding'
Select: 'San_Diego_Airphoto_34_rectified.ers'
6. Select the following options on the wizard page:
   ✔✔ Display image in 2D
   ✔ Manually set display method
   ✔ Mosaic all files of this type
   ✔ Manually set mosaic method
7. Click on the Next> button to go to the next wizard page.
8. Select the Cell size option. Do not select the other options on this page.
The images in this directory that we want to mosaic all have the same cell sizes, the wizard will reject the other images as their cell size is different.
9. Click on the Next> button to go to the next wizard page.
10. Select the Red Green Blue display option.
11. Click on the Next> button.
ER Mapper will display a mosaic of two Orthophotos
12. Click Finish to close the wizard.

Color balancing the mosaic

You can now use the Color Balancing Wizard for Airphotos to color balance the mosaiced images.

1. Click on the Color Balancing Wizard for Airphotos button on the Common Functions toolbar to open the wizard.

The wizard processes the currently active image window which you left open after the previous exercise.

2. Click on the Next> button to go to the next wizard page.
3. Click on the Next> button to go to the next wizard page.
The wizard will analyze images for balancing
The wizard requires the images to be analyzed before it can do the balancing. The analysis information is stored in the image dataset header files. If the images have not yet been analyzed, the wizard will now do so.
4. Click on the Next> button to go to the next wizard page.
5. Select the Balanced option
6. Click on the Next> button to go to the next wizard page.
The wizard will balance the images
7. Click on the Finish button to exit the Color Balancing Wizard for Airphotos.

Overlaying a dxf file

You can overlay GIS files in common formats. Here we will overlay a .dxf file.

1. In the Algorithm dialog box, from the Edit menu select Add Vector Layer and then AutoCAD DXF.
   A DXF Link layer is added.
2. Click on the Dynamic Link Chooser button on the Layer tab and choose the ‘Data_Types\AutoCAD_DXF\’ directory and the ‘San_Diego_Roads.dxf’ file.

The .dxf layer is drawn in white.

Going on from here

Explore the other algorithms supplied with ER Mapper. Also, open the Algorithm window by clicking the View Algorithm for Image Window button and observe how the processing is represented as you view different algorithms. You may use your own data. Read Chapter 3, Basics, in the ER Mapper User Guide for an explanation of how
ER Mapper 6.0
Helping people manage the earth

• Wizards • Map production • 3D presentations • Annotation • Orthophoto • Surface gridding • Contouring
• Image mosaicing • Data compression • Geocoding • Spatial analysis • Raster to vector
• Land use classification • Data integration • Image analysis • Radar processing • Fast Fourier Transforms

New features include:
✔ Free imagery plugins for GIS systems
✔ Orthorectification of airphotos
✔ Image display and mosaic wizard
✔ The Image Balance wizard
✔ The Geocoding wizard
✔ The Surface Gridding wizard
✔ The Contouring wizard
✔ Save as... to popular formats
✔ File open... directly from popular formats
✔ Image compression wizard
✔ Real time roaming and zooming
✔ Radar processing fully bundled

Authorized Reseller

ER Mapper is fully supported worldwide by 510 Reseller offices. Reseller enquiries welcome.

All brands, company names and product names are trademarks or registered trademarks of their respective holders. Not all functions are available on all platforms. Product specifications subject to change without notice.

ER Mapper 6.0
Helping people manage the earth
www.ermapper.com

Asia Pacific Region Office:
Earth Resource Mapping
Level 2
87 Colin Street
West Perth
Western Australia 6005
Telephone: +61 8 9388-2900
Facsimile: +61 8 9388-2901

European Region Office:
Earth Resource Mapping
Blenheim House
Crabtree Office Village
Eversley Way, Egham
Surrey, TW20 8RY, UK
Telephone: +44 1784 430-691
Facsimile: +44 1784 430-692

Americas Region Office:
Earth Resource Mapping
4370 La Jolla Village Drive
Suite 900
San Diego, CA 92122-1253, USA
Telephone: +1 619 558-4709
Facsimile: +1 619 558-2657

View ER Mapper images inside other software

View multi-surface 3D

View images and vectors in 3D

Mineral exploration

Oil and Gas exploration

Combine GIS and images to make great maps

ER Mapper is fully supported worldwide by 510 Reseller offices. Reseller enquiries welcome.

All brands, company names and product names are trademarks or registered trademarks of their respective holders. Not all functions are available on all platforms. Product specifications subject to change without notice.

ER Mapper
Helping people manage the earth
www.ermapper.com